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Work Shop 7.45 

The topics: 
How to Insert Tables into Word Documents 

Using the Malfunction Centre and Universal Docs. 
These  and other Workshops are open to all LCG-

OPEN members and friends. 
The Topics are not only interesting, but could be 

vital in some instances. 
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OPEN NEWSLETTER – Mar-Apl 2011 

 

OPEN Meetings  
 March 2  
 and April 6 

  at 1 pm 

  Coordinators Corner 

 
Shortcuts:a route shorter than the usual one. 
 
This month we are going to look at shortcuts for windows 7. Shorcuts are a great way of saving time and more so as 
you become more confident and proficient in your computer use. 
Switch between open windows       Alt + Tab 
Minimise/restore all but active window      Windows key + Home 
Minimise all windows        Windows key + M 
Maximise Window         Windows key + 
up-arrow 
Minimise/restore Window        Windows key + down-
arrow 
Make all windows transparent       Windows key + spacebar 
Dock windows to left or right half of screen     Windows key + left or right arrow 
Zoom in/out (In the default view, you must zoom in before zooming  
out) Windows key + plus/minus sign 
Lock screen          Windows key + L 
Open Run dialog         Windows key + R 
Open Search box         Windows key + F 
Open Windows Explorer to computer      Windows key + E 
Expand Folders view in Win Explorer to show where you are  Control + Shift + E 
Go up a level in Windows Explorer      Alt + up-arrow 
Choose display mode/switch monitors (Especially useful for  
presenters or Dual-monitor users)      Windows key + P 
Launch apps pinned to the Taskbar (1 is the left-most app: (Windows  
Key+T cycles through all apps)       Windows key + number 1-
9 
Cycle through Gadgets        Windows key + G 
Rotate a picture clockwise (or use comma for counter-clockwise) Control +  period  

 
Although keyboard shortcuts can be real time-savers, 
sometimes it’s hard to press multiple keys at once, 
(especially while you’re eating a sandwich or holding your 
phone in one hand). 
The Widows Sticky Keys feature lets you press one key at 
a time as you enter a shortcut. 
You can turn on Sticky Keys permanently by using the Con-
trol Panel’s Ease of Access Centre Options. 
Turn Mouse Keys on and off  
Left=Alt + Left-Shift + Num Lock 
The Windows Mouse Keys feature is a really useful short-
cut that lets you control the curser with the arrow keys on 
your  numeric keypad. Like Sticky Keys, it can be turned on 
permanently in the Control Panel’s Ease of Access Centre, 
but you can also invoke it at any time by pressing this key 
combination. This gesture turns you into a true keyboard 
jockey. 
Note that both Sticky Keys and Mouse Keys display a 
warning message when you turn them on and off. You can 
disable the warning boxes in the Control Panel’s Ease of 
Access Centre by choosing Set up Mouse Keys or Set up 
Sticky Keys. 
 
Rob Tierney. 
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 Workshop 
 
 following the LCG Meeting March 2. 
 
Approximate time 7.45 pm. 
 
The topics: 
 
How to Insert Tables into Word Documents 
 
Using the Malfunction Centre and Universal Docs. 
 
These  and other Workshops are open to all LCG-OPEN members 
and friends. 
 
The Topics are not only interesting, but could be vital in some in-
stances. 
 

OPEN NEWSLETTER – Mar—Apl  2011 

Tony  
has kindly obliged to show students who 
register  “How to create” a Power Point 
Presentation.  
March 30   1 pm—3 pm.  
 
Please put your name on Wednesday 
Registration sheet on the board near the 
front desk. 
 
 

Family History 
 
All Family History Classes will 
be held be-
tween 10 
and noon. 
March 16 

 
WAITING LISTS 

 
Those who are interested in becoming  

students or want to learn specific areas of  
Computing 

are required to have their names registered in the 
Waiting List book at the front desk. 

 
You will be notified by a tutor as soon as a space  

becomes available. 

GRAPHICS WORK SHOPS 
 

March 1  10 am—noon    
    April 6      10 am—noon 

 

NOTE To new students. 
Please ensure you know your 

email account and passwords to 
get into computer and learn more  

about the Internet. at OPEN. 

PHOTO RECORDS 
A delightful Canon Photo Program which allows 
photoholics to make up interesting albums from 
their collection of treasured photographs. 
Place names on Registration Sheet near the desk 
so that Eleanor has an idea of the amount of inter-
est in this subject. 
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Monday 10 am –12  General &  

Monday 1 pm – 3 pm Beginners & PC 
Support 

Monday 3.30—5.30 P C Support & Begin-
ners  

Tuesday 10 - noon  PC Support, Begin-
ners +Mac Support 

Tuesday 1 pm –3 pm As above 

Tuesday  7 pm—9 pm P C Support 

Wednesday  10 am –noon Registered classes & 
Meetings 

Wednesday 1 pm—3 pm As per roster 

Thursday 10 am –12  
 

General &  
Beginners  

Thursday 1 pm – 3 pm General &  
Beginners  

Thursday 3.30—5.30 Absolute Beginners 

Friday 10 am –12  General &  
Beginners 

Friday 1 pm—3 pm Beginners 

OPEN Session Times 
At Studioworks, 1 Pipeworks Rd, L’ton 

 

Standard Sessions $5.00  
SPECIAL  WEDNESDAY SESSIONS 

Please register on the sheets – numbers may be limited  

Date Time Topic Details 

March 2 10 am—noon Graphics Workshop With  Judy, Margaret, Sandra, Lynne & Laraine 

March 9 10 am—noon Basic Graphics Judy, Karia, Laraine, Lynne & helpers 

March 9 1 pm—3 pm Photo Records  Eleanor will show us through this clever program 

March 16  10 am—noon Family History Judy, Sandra and the team. 

 1 pm—3 pm Level 2-3 Graphics With Eleanor, Karia, Lynne, Sandra & team 

March 23 10—noon 
  

Family History  Judy Hall teaches how to find  records 

 1 pm—3 pm PSP X1 Graphics Eleanor, Karia, Margaret, Laraine  Sandra & Co. 

March 30 10—noon Basic Graphics You’ll never throw old photos away again. 

 1 pm—3 pm Power Point Presentations Learn how to make your own presentation. 

Graphics Workshop 
Helps grasp what has been learnt thus far. 

April 6                 10—noon               

OPEN NEWSLETTER – Mar-Apl 2011 

Club Helpline ………………………...VICTOR Phone No. 0408174235  
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OPEN NEWSLETTER – Mar—Apl  2011 More get well messages 
 

Wishing all Tutors and students who have been on the sick 
list or have their time taken up with full time caring  all the 

best for the remaining year. 
 

To those recovering from serious health prob-
lems,                              

we are pleased to hear you a 
on the  road to recovery        

especially two “Mac tutors”                  Ivan 
and Reinhard. 

 
LCG Committee 2011 

 
President: Ivan Turmine 
 
Vice President: Janet Headlam 
 
Minutes Secretary: Iris Meek 
 
Treasurer: Barry Symons 
 
Ass. Treasurer: Laraine Rist  
 
MAC Librarians: Ivan Turmine 
 
PC Librarian: Julie Hjort 
 
Newstream Editor: Ron Baker 
 
Publicity Officer: Iris Meek 
 
Maintenance Co-ordinator; Dennis Murray 
 
OPEN Co-ordinator: Robert Tierney 
 
Webmaster/Content: Tom Olsen 
 
Auditor: Ron Baker 
 
"VICTOR" Co-Ordinator: Robert Tierney 
 
General Committee: Glenn Gilpin, Reinhard von Samorzewski 

   

VENUE TELEPHONE NUMBER 
63434928 

 

The club telephone 
is  available 

 during class hours. 
10am –3 pm 

 
  6343 4928    

OPEN Committee 2011 
Chairperson   Robert Tierney 
Co-ordinator  Rob Tierney 
Vice Chairperson  June  Hazzlewood 
Minute Secretary  Eleanor Horder 
Treasurer   Barry Symons 
O Learn Co-ordinator Eleanor Horder 
Tutor Co-ordinator  E Horder 
Assist Treas.  Laraine Rist 
Membership Co-ord. K Wicks 
Newsletter Editor           Iris Meek 
Publicity   I Meek 
Committee:   Heather Loffell,  
Marie Cleaver, Kay Dawson, Irmgard Rosenfeldt, Pauline 
Hardy, Sandra Viney, Janet Headlam.  

 Basic Graphics 
 Wednesday March 9   10 am—noon 

 
Wednesday March 30  10 am—noon 

 

 

Evening O Learn Classes with Rob Tierney 
 

Mondays and Thursdays 
3.30—5.30 

PSP X1 Graphics  
 

Advanced Graphics classes  
 
March 23 and April 27                 1 pm—3 pm. 
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PR I N TI N G  OD D  OR  EV E N  PA G ES  
There may be many times that you need to print either odd or even pages in a print 
job. For instance, you may want to put your pages through the printer twice so you 
can print on both sides. This is easy to do in Word by following these steps: 

1. Press CTRL+P. Word displays the Print dialog box. 

Print dialog box. 

2. Adjust the printing settings as desired. 
3. Using the Print drop-down list at the bottom of the dialog box, choose 

either Odd Pages or Even Pages, as desired. (Make sure you use the 
Print drop-down list, not the Print What drop-down list.) 

4. Click on OK. Your document is printed. 

The above steps work great in any version of Word up through Word 2007. If you 
are using Word 2010, then the Print dialog box was done away with. You should 
follow these steps, instead: 

1. Press CTRL+P. Word displays the File tab of the ribbon, with printing 
options visible in the tab. 

2. Adjust the printing settings as desired. 
3. Using the first drop-down list under the Settings heading, choose Only 

Print Odd Pages or Only Print Even Pages, as desired. 
4. Click on Print. Your document is printed. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of 
free Microsoft Word tips can be found online at http://word.tips.net. 
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D I S P L AY ING  A  H ID DEN  F IR S T  
CO L UM N  
Excel makes it easy to hide and unhide columns. What isn’t so easy is displaying a 
hidden column if that column is the left-most column in the worksheet. For 
instance, if you hide column A, Excel will dutifully follow out your instructions. If 
you later want to unhide column A, the solution isn’t so obvious. 

To unhide the left-most columns of a worksheet when they are hidden, follow 
these steps: 

1. Press F5. Excel displays the Go To dialog box. 

 

The Go To dialog box. 

2. In the Reference field at the bottom of the dialog box, enter A1. 
3. Click on OK. Cell A1 is now selected, even though you cannot see it on 

the screen. 
4. Unhide the column. (In Excel 2007 or Excel 2010, display the Home tab 

of the ribbon and click Format | Hide & Unhide | Unhide Columns. In 
older versions of Excel choose Format | Column | Unhide.) 

Another way to display the first column is to click on the header for column B, 
and then drag the mouse to the left. If you release the mouse button when the 
pointer is over the gray block that marks the intersection of the row and column 
headers (the blank gray block just above the row headers), then column B and 
everything to its left, including the hidden column A, are selected. You can then 
unhide the column. 

A third method is even niftier, provided you have a good eye and a steady mouse 
pointer. If you move your mouse pointer into the column header area, and then 
slowly move it to the left, you notice that it turns into a double-headed arrow with 
a blank spot in the middle as you position the pointer over the small area 
immediately to the left of the column B header. This double-headed arrow is a bit 
difficult to describe; it looks most closely like the double-headed arrow that 
appears when you position the pointer over the dividing line between column 
headers. It is different, however, because instead of a black line dividing the 
double arrows, there are two black lines with a gap between them. 

When your mouse pointer changes to this special double-headed arrow, all you 
have to do is right-click and choose Unhide. Your previously missing column A 
magically reappears. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of 
free Microsoft Excel tips can be found online at http://excel.tips.net. 
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itself.  For a great introduction to using keyboard shortcuts, 
check out Gizmo's Dec.  3, 2009, column.  For general strategies 
and more tips, see Scott Dunn's Feb.  25, 2010, column. 
 
But hundreds of keyboard shortcuts for commands in Windows 
and widely used apps such as Internet Explorer and Office are 
not explicitly hinted at in menus and dialog boxes.  In other 
words, you need to actually learn them. 
 
I can hear you groaning.  Yes, learning a whole bunch of 
keyboard commands is not my idea of a fun way to spend a 
weekend, either, but if you judiciously pick a few, list them in a 
cheat sheet that you stick on your monitor, and practice them for 
a week or two, they'll become second nature. 
 
Top 20 shortcuts for taming your windows Managing windows 
is probably one of the most fertile areas for keyboard shortcuts 
because otherwise, you manipulate them solely with the mouse.  
Here's my top-20 list of must-know shortcuts for taming your 
windows; you'll never have to move your hands from the 
keyboard.  For completeness, I've included many keyboard 
shortcuts you might already be familiar with; skip down the list 
to see the ones you don't know. 
 
Switch between open windows Alt + Tab Minimize/restore all 
but the active window Windows key + Home Minimize all 

(Continued on page 10) 

A complete guide to Windows 7 keyboard shortcuts Becky 
Waring By Becky Waring One of the best ways to increase your 
computing productivity doesn't cost a cent: learn the keyboard 
shortcuts for your most-used commands. 
 
To help you stop mousing around and become a keyboard 
maestro, I rounded up the best resources for finding, using, and 
creating shortcuts. 
 
Lincoln Spector struck a nerve with his Jan.  13 column, 
"Twenty-six ways to work faster in Windows 7." Many of those 
tips involved keyboard shortcuts.  After all, almost any time you 
can use the keyboard instead of the mouse, you work faster.  But 
there are lots more shortcuts where those came from.  This 
article aims to show you where to find the ones that can speed up 
your workflow.  In case you can't find the shortcuts you need, I'll 
show you how to create your own. 
 
You probably already know that you can invoke many menu and 
dialog-box items via the keyboard by pressing the Control or Alt 
key plus an underlined letter.  For example, pressing Alt + F in 
most apps opens the File menu; then pressing the underlined 
letter N opens a new document.  You might also know that when 
you press Alt + A, you apply dialog-box changes. 
 
Direct keyboard shortcuts to menu commands (such as Ctrl + C 
for Copy) are typically shown next to the command in the menu 
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windows Windows key + M Maximize window Windows key + 
up-arrow Minimize/restore window Windows key + down-arrow 
Make all windows transparent so you can see the desktop 
Windows key + spacebar Dock window to left or right half of 
screen Windows key + left- or right-arrow Zoom in/out (In the 
default view, you must zoom in before zooming out.) 
Windows key + plus/minus sign Lock screen Windows key + L 
Open Run dialog Windows key + R Open Search box Windows 
key + F Open Windows Explorer to computer Windows key + E 
Expand Folders view in Win Explorer to show where you are 
Control + Shift + E Go up a level in Windows Explorer Alt + 
up-arrow Choose display mode/switch monitors (Especially 
useful for presenters or dual-monitor users) 
Windows key + P Launch apps pinned to the Taskbar (1 is the 
left-most app; Windows Key+T cycles through all apps.) 
Windows key + (number 1-9) 
Cycle through Gadgets Windows key + G Rotate a picture 
clockwise (Or use comma for counterclockwise) 
Control + period Use Control-click to select the pictures in a 
folder you need to rotate, then rotate them all at once. 
Turn Sticky Keys on and off Press Shift five times Although 
keyboard shortcuts can be real time-savers, sometimes it's hard 
to press multiple keys at once, (especially while you're eating a 
sandwich or holding your phone in one hand).  The Windows 
Sticky Keys feature lets you press one key at a time as you enter 
a shortcut.  You can turn on Sticky Keys permanently by using 

(Continued from page 9) the Control Panel's Ease of Access Center options. 
Turn Mouse Keys on and off Left-Alt + Left-Shift + Num Lock 
The Windows Mouse Keys feature is a really useful shortcut that 
lets you control the cursor with the arrow keys on your numeric 
keypad.  Like Sticky Keys, it can be turned on permanently in 
the Control Panel's Ease of Access Center, but you can also 
invoke it at any time by pressing this key combination.  This 
gesture turns you into a true keyboard jockey. 
Note that both Sticky Keys and Mouse Keys display a warning 
message when you turn them on and off.  You can disable the 
warning boxes in the Control Panel's Ease of Access Center by 
choosing Set up Mouse Keys or Set up Sticky Keys.  This list is 
just a sample of the dozens of shortcuts available.  For a full 
accounting of Windows 7 interface shortcuts, see Microsoft's 
Windows 7 Help & How-to site. 
 
Other programs and lots more shortcuts Although the global 
Windows 7 shortcuts are the headliners, you will probably save 
the most time by getting to know the keyboard shortcuts in 
frequently used applications such as your Web browser, e-mail 
program, and word processor. 
 
Here are links to handy keyboard shortcut reference guides for 
many popular apps, along with my favorite shortcut discoveries 
made researching this article: 
 

(Continued on page 11) 
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* Internet Explorer.  (shortcuts) Try Control+Shift+P to open an 
InPrivate browsing window; try Control + E to go to the Search 
box. 
 
* Firefox.  (shortcuts) Select the exact tab you want with 
Command + 1 to 8.  Command + 9 chooses the last tab. 
 
* Chrome.  (shortcuts) Press Alt and click a link to download its 
target, such as a picture or PDF file. 
 
* Office 2010.  (shortcuts) Use the keyboard to work the ribbon 
interface in all Office programs.  This is a huge timesaver.  Also, 
create your own shortcuts by first clicking the File tab to open 
Backstage view.  Then choose Options/Customize 
Ribbon/Keyboard, then Shortcuts/Customize to enter your own 
key combinations or to change existing ones, as shown in Figure 
1. 
 
 
 
 
 
 
 
 

(Continued from page 10)  
 

Office 2010 shortcuts Figure 1.  The keyboard customization tool in Office 2010 
* Word 2010.  (shortcuts) Press Shift + F7 to open the 
Thesaurus.  My new favourite function key!  Lots of great 
formatting, selection, and navigation shortcuts here, too. 
 
* Excel 2010.  (shortcuts) Control + Shift + : enters the current 
time.  Control + Shift + & adds a border around the selected 
cells. 
 
* OneNote 2010.  (shortcuts) I've fallen in love with the ability 

(Continued on page 12) 
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more than a pretty face. 
 
You're probably already familiar with many of the Windows 7 
interface effects, especially Aero Peek, but others, like Shake, 
are relatively obscure.  If you haven't discovered these tricks, 
you're really missing out. 
 
Yes, they're mouse shortcuts rather than keyboard shortcuts (and 
most have keyboard equivalents), but give them a try.  
Sometimes you have your hand on the mouse or trackpad 
already, which makes these mouse tricks faster than keyboard 
combinations to access.  And they're much more fun. 
 
* Peek.  Hovering over a program icon in the taskbar gives you a 
thumbnail preview of open windows for that program. 
 
* Shake.  Click and hold your main window on the screen, and 
then "shake" it with your mouse to minimize or restore all other 
windows.  This shortcut lets you focus on the task at hand.  It 
works like the Windows key + Home combination. 
 
* Flip 3D.  This trick is way cooler than Alt+Tab: holding down 
the Windows key while repeatedly pressing Tab visually flips 
you through your open windows.  (See Figure 2.) To flip 
backward, hold down the Shift key, too. 
 

(Continued on page 13) 

to move the current paragraph or selected paragraphs up or down 
in a document by pressing Alt + Shift + up- or down-arrow. 
 
* Outlook 2010.  (shortcuts) Enter Control + Shift + I to switch 
to your Inbox (or Control + Shift + O to move to your Outbox). 
 
* Thunderbird.  (shortcuts) Press F8 to toggle the message pane 
on and off; press T to jump to the next unread thread. 
 
* Windows Media Player 12.  (shortcuts) Alt + Enter toggles full-
screen video. 
 
* Adobe Photoshop CS5.  (shortcuts) Adobe is kind enough to let 
you use theirs or build your own shortcuts right in the program. 
 
With a little Googling, you can find more lists of shortcuts for 
most any program you use regularly. 
 
Better than shortcuts: Windows Aero tricks First introduced in 
Windows Vista, the Windows Aero interface comes of age in 
Windows 7 and is part of all editions except Starter and Home 
Basic.  Critically, most Windows 7 PCs actually have the 
horsepower to run Aero smoothly (many Vista users were 
chagrined to learn their computer either wouldn't support Aero or 
ran sluggishly), and new usability features make Aero much 

(Continued from page 11) 
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* Snap.  Drag the title bar of a window to the top of the 
screen to maximize, or drag it to the right or left edge of the 
screen until an outline of the window appears to make it fill 
the right or left half of the screen.  The latter maneuver 
makes it a snap to arrange two windows side by side.  This is 
the mouse equivalent of Windows key + left- or right-arrow. 
 
 
 
 
 
 
 
 
 
 
Aero Flip 3D effect Figure 2.  Windows Aero Flip 3D lets 
you visually sift through open windows. 
 
If Aero effects are not presently working on your Windows 7 
installation (or only partially working), you may not have 
the horsepower to run the full Aero interface.  Or you may 
need to enable Aero effects because they depend on your 
Windows Experience Index. 
 
To enable Aero (or check your ability to run it), go to 

Control Panel/System & Security/System and run or refresh the 
Experience Index.  Then choose Advanced system 
settings/Advanced/Performance settings to see what Aero 
effects are enabled for your system. 
If not all effects are enabled, click Custom and check the 
additional effects you want to use.  If these effects perform 
poorly, you can always go to the same settings to disable them. 
 
How to play God and create program shortcuts If you spend 
any time following Windows news, you've probably read one or 
more of the recent stories on the Web about the so-called 
GodMode, the Windows 7 tweak du jour.  This is nothing more 
than a searchable/clickable list (see Figure 3) of all system and 
Control Panel tasks, produced when you create a special folder.  
(Ed Bott describes similar shortcuts in one of his blogs.) 
 
GodMode has no extra powers or capabilities.  But it does let 
you easily assign keyboard shortcuts to any task in the list, 
which is undeniably cool. 
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God mode folder Figure 3.  The God Mode folder contains a 
searchable list of system tasks. 
 
So you could create keyboard commands for tasks such as 
adjusting your monitor resolution, showing hidden files and 
folders, blocking or allowing Internet Explorer pop-ups, or 
viewing network connections. 
 
To do so, simply create a folder on your desktop with a name 
and a globally unique identifier (GUID) number, such as 
GodMode.{ED7BA470-8E54-465E-825C-99712043E01C}.  
(Warning: Creating a God Mode folder reportedly crashes 64-bit 
Vista systems.  Use at your own risk in any OS but Windows 7.) 
 
Next, open the folder and right-click the setting for which you 
want to make a shortcut.  Finally, right-click the newly created 
shortcut, choose Properties/Shortcut, and enter your choice of 
key sequences to invoke it.  Press Apply and close the dialog 
box. 
 
When you create your own sequences, try to stay away from 
anything already used by Windows or by your main programs.  
The Control + Shift + Function key territory is relatively 
uncharted. 
 
Note that you can use this last trick to create keyboard shortcuts 

(Continued on page 15) 
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for any programs or documents you use frequently, not just the 
GodMode tasks.  Simply right-click the program name in the 
Start menu and choose Properties/Shortcut/Shortcut key.  Do the 
same for documents by first creating a clickable shortcut and 
then a keyboard shortcut. 
 
Using KeyText and AutoHotKey for shortcuts Want even more 
shortcuts?  Start rolling your own with a keyboard macro utility.  
These apps let you create standard shortcuts not only for menu 
items but also for sequences of actions, including tasks such as 
entering text and clicking buttons in a dialog box. 
 
Macro utilities for Windows 7 are not as plentiful as they used to 
be for XP.  (And my all-time favorite, QuicKeys, has not been 
updated for Vista or Windows 7.) But I found a couple that do 
the job for little or no money. 
 
The first is MJMSoft's KeyText 3 (U.S.  $29.95, info page).  
KeyText (see Figure 4) is an amazingly versatile program that 
can automate tasks such as opening your e-mail program and 
creating a new message using an e-mail address you've selected 
in another program. 
 
It even supports regular expressions and if/then/else logic, so 
you can conduct search-and-replace operations or batch-file 
renaming, as well as perform different actions that depend on the 
result of a search. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
KeyText 3 menu Figure 4.  KeyText 3's macro menu can be 
invoked from the system tray or via a hotkey.  You can also 
assign direct hotkeys to any item. 
 
Learning how to harness all this power requires a little work, but 
you can use both the contextual help and a very good PDF 
manual (albeit one not updated since Vista).  You'll have no 

(Continued on page 16) 
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trouble learning simple tasks such as assigning trigger text to an 
action.  A trial version of this software is available. 
 
AutoHotKey (info page) is another versatile option for creating 
your own shortcuts.  This free and open-source utility requires 
significantly more effort to learn and use than KeyText, but it 
has a very active community forum where you can get help 
quickly; it also has good documentation. 
 
AutoHotKey is basically a macro scripting language that 
requires you to write simple programs for your shortcuts using a 
text editor like NotePad.  After saving your shortcuts with the 
.ahk extension, you can then run them in the background by 
double-clicking them, or you can set them as startup items. 
 
AutoHotKey's command list (page) is quite versatile, and 
programmers are likely take to it in a flash.  The rest of us can 
get by with the included AutoScriptWriter macro recording 
utility, which — as advertised — "watches where you type and 
what you click, and keeps track of which window is active." 
 
KeyText is considerably easier to use than AutoHotKey, and 
both powerfully fulfill almost every Windows 7 automation 
need.  Even so, there's room for a simpler utility with a great 
graphical user interface, such as the old QuicKeys.  If you know 
of one, please tell us in the Lounge.  In the meantime, try out 
some of the pre-programmed suggestions above. 

LAUNCESTON COMPUTER GROUP 
 

Minutes of Meeting held at Studio Works 1 Pipeworks Rd  
February 2 2011 

Meeting opened 8.10 pm Janet Headlam (Vice president) in chair. 
 
Apologies: June and Bert Hazzlewood,.Judy Hall, Julie Hjort, Reinhard 
von Samorzewski, Ivan Turmine and Sandra Viney,  
 
Present: Barry Symons, Ted Bramich, Eleanor Horder, Dennis Murray, 
Laraine Rist, Harvey Tavener, Tom Olsen, Janet Headlam, Glenn Gilpin,  
Ron Baker and Iris Meek. 
 
Minutes of previous meeting confirmed H Tavener/E Horder Car. 
 
Business Arising: Some problems with Cleaner resolved. Open meeting 
had suggested that if anyone wanted to make suggestions on what 
should be included in the job description should be written down and 
placed in the suggestion box where they would be followed up by OPEN 
committee. 
An extra member required for Tutor Assessment panel following the res-
ignation of Margaret Carrington. 
It was noted Tony Garrett has fitted well into the club as a tutor. 
The meeting felt the Tutor Wallets should stay recognisable from Stu-
dent Wallets. 
If Tutor Meetings could not be held regularly, other means of meeting 
new students needs to be found. 
 
Correspondence: Letter of resignation from M Carrington, Dept of Jus-
tice: Requirements for Audit purposes and form for Public Officer., 
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Emails from Ivan Turmine. Email from Tom Olsen re Bookkeeping Train-
ing Course. 
Financial Report: as the audit will not be available until the March meet-
ing, the former treasurer could not read the Profit and Loss statement, 
but the Monthly Accounts slips with accounts paid and to be paid were 
presented. Payment of $15 to Tas Printer Cartridge for inks $15, Dennis 
Murray for hardware including motherboard and opportunistic purchase 
of new printer $319 plus Another Computer Store for December and 
January rent including the holidays period approx $1250 plus LCG com-
ponent $200. Moved I Meek/J Headlam report be accepted. Car. 
General Business:  
The club will make enquiries with financial institutions re investing 
money to get a little interest. The idea was put and carried unanimously. 
Several attempts have been made to start an Inventory of the clubs as-
sets and each time a start is made, further details have not been 
added. A suggestion was made that a photographic or videoed record 
could be made. This will need to be discussed further next meeting. 
Tom Olsen suggested  accounts should be paid on line. He also had sev-
eral ideas to improve the book keeping procedures at the club, but this 
was left in abeyance due to the fact that our most experienced book 
keeper cum maintenance man has a paid work load and cannot make 
himself available for any more than at present. There were several com-
ments re the program used by OPEN-LCG for keeping the books. Sug-
gestions included the return to Excel, the Windows Money program or 
retaining MYOB. 
Iris Meek said the Treasurer used MYOB and the assistant treasurer 
was using Excel. Ron uses the Windows program. The new treasurer 
may choose a different system. 
Open had discussed whether the club constitution could be put on the 
Web page. Our meeting readily agreed to this and Tom will follow up on 
the matter. 
From June Hazzlewood OPEN meeting; A combined meeting of the two 

committees and tutors would do much to relieve the current feelings of 
separation amongst some of the members. The secretary was asked to 
send out an email to this entire group to ask for two suggested times 
which would suit….eg. Wed afternoon at 5.30…Monday  at ??? Saturday 
at ????? time.  This could be sorted into the time most suited to all com-
mittee persons and a date then set. Perhaps a  dinner or afternoon tea 
at a quiet spot or someone home… 
It was also suggested that an occasional IT hook up could be arranged 
to get everyone’s opinion. 
Glenn Gilpin asked if Tom could let the secretary know when the News-
letters go on line so that the secretary could notify members to go to the 
web page. 
Ron wants to get all information for the Newstream in one week before 
the meetings. 
New signatories to be added to bank list and enquiry into having online 
access. Secretary to follow up.. 
 
Glenn suggested that the next market date be set at the March meeting 
as he had still had no reply from the Show Society. The market place is 
used extensively for yearling sales at this time of year. 
 
Dennis has completed the work on Computer #14 and suggests it could 
replace the old Online Access acquisition used by Admin. 
 
Due to the lateness of this meeting Dennis Murray was asked if he 
could prepare the What’s in a Computer workshop until March. Thank 
you Dennis. 
Secretary to get all names of new committee to Tom Olsen ASAP for web 
posting. 
Next Meeting March 2 at 7.15. 
Meeting close at 9.20 pm. 
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Gentle Lessons of Life  
A penny saved is obviously the result of a government oversight. 
 
 The real art of conversation is not only to say the right thing at the right 
time, but also to leave unsaid the wrong thing at the tempting moment. 
 
The older you get, the tougher it is to lose weight, because by then your 
body and your fat have gotten to be really good friends. 
 
The easiest way to find something lost around the house is to buy a new 
replacement for it 
 
He who hesitates is probably doing the right thing. 
 
Did you ever notice: The Roman Numerals for forty (40 ) are ' XL.' 
 
If you think there is some good in everybody, you obviously haven't met 
'everybody'.   
 
If you can smile when things go wrong, you must have someone else in 
mind to blame. 
 
 The sole purpose of a child's middle name is so that he can tell when he's 
'really' in trouble. 
 
There's always a lot to be thankful for if you take time to look for it..  For 
example, I am sitting here thinking how nice it is that wrinkles don't hurt. 
 
Did you ever notice: When you put the 2 words 'The' and 'IRS' together it 

spells 'Theirs.'  
 
Aging: Eventually you will reach a point when you stop lying about your 
age and start bragging about it. 
 
The older we get, the fewer things seem worth waiting in line for. 
 
Some people try to turn back their life's odometers.  Not me, I want people 
to know 'why' I look this way.  I've travelled a long, long way and some of 
the roads weren't paved.   
 
When you are dissatisfied and would like to go back to youth, think of 
Algebra. 
 
You know you are getting old when everything either dries up or leaks. 
 
One of the many things no one tells you about aging is that it is such a nice 
change from being young. 
 
Ah, being young is beautiful, but being old is comfortable. 
 
First you forget names, then you forget faces.  Then you forget to pull up 
your zipper.  It's even worse when you forget to pull it down. 
 
Long ago when men cursed and beat the ground with sticks, it was called 
witchcraft.  Today, it's called golf 
 

PDF created with pdfFactory trial version www.pdffactory.com

http://www.pdffactory.com
http://www.pdffactory.com


Page 19  

CONFUSION EXPLAINED 
 

Names or numbers? Perhaps names and numbers? 
 
This is the dilemma I often face when trying to work out what the creators of 
software are thinking when they name their new products. 
 
And what has prompted this line of thought? In a word (or two) Windows 7. 
Occasionally I hear people talk about Windows 2007, while others have asked 
me the significance of the ‘7’. 
 
Firstly, let me erase the Windows 2007 reference. Microsoft’s latest operating 
system was not released until 2009 so the 2007 reference is clearly incorrect. 
 
So why Windows 7? It may not be generally well-known that each of the 
preceding Windows operating systems (OS) had a number but the 
marketing men obviously decided on names that were a bit more 
esoteric. 
 
Windows 6 was Vista ... perhaps to conjure up thoughts of a new 
view of computing? Windows 5 was XP, denoting Xtra Perform-
ance, while Windows 4 had several variations stretching all the 
way from Windows 95 to Windows 2000. 
 
Prior to Windows 95 the ‘3’ series referred to Microsoft operating 
systems that ran on the old DOS formats. But we probably don’t 
need to go back more than 15 years investigating the theory. 
 
I think Computing life would have been much simpler if Microsoft had named 
their operating system “Magnificent (Seven)” or “Lucky (Seven)” . 
 

Dennis Murray 

The very first "senior moment."    
 

And that's what happened to the dinosaurs! 
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